
1

Physiological Dynamics in Animals and Plants - Laboratory 2 -
Measurement of the Light Dependence of Photosynthesis

Introduction:

This laboratory is a modified version of an exercise developed by Dr. Diane C.
Robertson, Biology Department, Grinnell College, Grinnell, Iowa  50112.  All of the
exercises developed by Dr. Robertson are available at:

http://www.grinnell.edu/courses/bio/qubitmanual/

Today's physiological phenomenon – The “light reactions” of photosynthesis:

Photosynthesis is the single most important autotrophic (self-feeding) mechanism by
which organisms, terrestrial and aquatic, capture solar energy from outside the earth and
convert it to a form that provides the metabolic energy they need to survive, grow, and
reproduce.  In photosynthesis, radiant light energy is converted to chemical energy that is
then used to synthesize sugars that are the food for plants and all other organisms that
depend on plants to produce their food for them (heterotrophs).

A green pigment, chlorophyll, is the central light-absorbing pigment that makes this
energy interconversion possible.  Along with various other accessory pigments,
chlorophyll is harbored in the chloroplasts of cells in the aerial portions of plants.  Most
chlorophyll is found in leaves, organs that are evolved to capture light.

In the “light reactions” of photosynthesis, light strikes these pigments and all of the
absorbed energy is funneled to a special subset of chlorophyll molecules.  This energy
transfer causes the ejection of electrons from certain atoms in the chlorophyll molecules
(the chlorophyll becomes oxidized).  The ejected electrons are passed sequentially
through a series of chloroplast proteins, reducing one, and then the next, and then the
next, etc.  The electrons ultimately end up reducing a compound called nicotinamide
adenine dinucleotide phosphate (NADP+).  Since the addition of an electron to the one
proton that confers the + charge on this compound produces a hydrogen atom, the
reduced compound = NADPH.  Energy from light-driven electron flow is also captured to
drive the synthesis of adenosine triphosphate (ATP) by a membrane-dependent
mechanism called chemiosmosis.

In the “dark reactions” of photosynthesis, electrons from NADPH and energy from ATP
breakdown are used, respectively, to reduce other small organic compounds (metabolites)
and form covalent bonds between their carbons.  The carbon atoms of these metabolites
come originally from carbon dioxide (CO2) that plants capture out of “thin air”; air is
only 0.0365% CO2.  The products of the dark reactions are simple 6-carbon sugars like
glucose and fructose.  Glucose and fructose can be covalently joined to form sucrose,
common table sugar.
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Although it is a gross oversimplification, most textbooks reduce photosynthesis to the
following chemical equation:

6 CO2 + 12 H2O à C6H12O6 + 6 O2 + 6 H2O

Note that photosynthesis consumes CO2, but it liberates O2; thus, changes in
concentrations of either gas over time can be used to measure rates of photosynthesis.
Today, we will measure rates of O2 liberation from illuminated leaves.

Where does the O2 liberated in the light reactions come from?  If the electrons ejected
from chlorophyll were not replaced, photosynthesis would eventually stop because the
light reactions would cease.  The electrons lost initially from chlorophyll are replaced
with electrons from water.  During the light reactions, water is “split” - 2 H2O à 4 H+ + 4
e- + O2.  The electrons from water are used to reduce NADP+; the protons are used in
chemiosmotic ATP synthesis; and the O2 is liberated into the air.  All aerobic organisms,
including you, me, and the plants, require O2 for our cellular respiration.  Thanks to
photosynthesis, the concentration of O2 in air is about 20.7%.

Measure the “light reactions” of photosynthesis:

Demonstrate to yourself that leaves produce O2 at rates that are in direct proportion to the
intensity of light to which they are exposed.  At some point your leaf may reach a “light
saturation point” above which more light will not increase the rate any further.  At that
point, photosynthesis is limited either by the ability of the light to convert the light energy
it absorbs to chemical energy or by the supply of some other factor required for
photosynthesis, such as CO2.  You should also determine whether altering the wavelength
(color) of light has an effect on the rate of water splitting.

Step 1 - Read:  Visit http://www.grinnell.edu/courses/bio/qubitmanual/ and read the
“Overview” and “General Setup” sections of the exercise entitled “Measurement of
Photosynthesis using O2 sensor.”

Step 2 - Do:  Do the following:

Set up the instruments:

1) Plug the USB cable from the Vernier LabPro into the USB port nearest to you on
the left side of the iBook.

2) Turn on the multi-outlet power strip.

3) Plug in the iBook; turn it on.  (NOTE:  The USB cable from the LabPro must be
plugged in before the iBook is turned on; otherwise, the computer will not "see"
that the LabPro is plugged into the USB port.).

4) Cancel or quit any start up programs (e.g. Norton Antivirus).
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5) When the desktop screen appears, launch Logger Pro by double-clicking on the
“Logger Pro alias” icon on the desktop.  If you get this message - "Cannot find the
preferred experiment folder.  Using default experiment folder." - hit OK.

6) Pull down the “Setup” menu and choose "Sensors."

7) Click on the Icon for CH1; Use the pull down menus that pop up to set channel 1 to
"O2 Gas Sensor"; set calibration to "O2gas20."

8) Click on the Icon for CH2; set channel 2 to "Light Sensor"; calibration =
"W_300qu"; hit OK.

9) Pull down the "View" menu and select "Graph Layout"; select "Two panes"; hit
OK.

10) On the upper graph, click on "Mixed labels"; leave the Oxygen box checked;
uncheck the "Med White" box and any other boxes; click OK.

11) On the lower graph, click on "Mixed labels"; leave the "Med White box checked;
uncheck the Oxygen box and any other boxes; click OK - the upper graph will
display oxygen, the lower one, light intensity.

12) Pull down the Setup menu and choose "Data Collection"; choose "Sampling"; set
the "Time Units" to minutes; set the "Experiment Length" to 120 minutes: set the
"Sampling Speed" to 6 samples per minute; click OK.

13) Click on the "Y" axis of the top graph; set the "Y-axis scale" to a minimum of 16
and a maximum of 22; hit OK.

(NOTE:  If your data go off scale, these values can be changed during data
collection by this same procedure without stopping the sampling; the arrows at the
top and bottom of the Y axis label can also be used to "slide" the scale if your data
go off scale.  As an alternative you can try "Autoscale")

14) Click on the "Y" axis of the bottom graph; set the "Y-axis scale" to a minimum of 0
and a maximum of 300

15) You are ready to collect data.

Experimental:

1) With the light off, seal a leaf inside the chamber so that no part of the leaf is
shaded.  Adjust the position of the leaf so that the top leaf chamber is not
completely sealed off from the bottom leaf chamber.  It does not matter if the leaf
is too large to be fully sealed within the chamber.  The excess may protrude out of
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the chamber without affecting your results.  When you seal the chamber, turn the
thumb-screws finger tight only; don't crush the leaf!

2) Place a beaker with 200 mL of water on top of the chamber so that it covers the
major part of the leaf area.  This serves as a heat filter; the water should be
changed every 10-15 minutes (have a fresh beaker ready) to prevent heating
(burning) the leaf.  Position the light above the beaker so that its bottom edge is 11
cm from the top of the leaf chamber.

3) Click on the "Collect" button at the top of the screen.  The button will change to a
"Stop" button and data will begin to appear on the two graphs on the screen and as
numerals on the bottom of the screen.  The initial O2 should be around 20.7%; if it
is more than 1% different, use a screwdriver to adjust the gain on the amplifier box
to calibrate it - you can watch the concentration change on the bottom of the
screen.

4) Using the tubing provided, flush the chamber gently, but completely, with your
breath; quickly plug the top and bottom chamber ports.  Depending on your
metabolic condition, the O2 concentration should drop to between 16 and 18%.
Wait until this value stabilizes, then turn on the light to full intensity and record the
irradiance, reading its value at the bottom of the screen.

5) There will be little change in the O2 reading for the first 5-15 minutes of
illumination.  This corresponds to the "induction period" for photosynthesis during
which photosynthetic metabolites are synthesized until they reach critical pool
sizes required for photosynthesis to occur.  It also takes some time for stomata to
open.  Once this has been achieved, the partial pressure of O2 (pO2) in the chamber
will increase as O2 is released by photosynthetic water splitting.  After the
photosynthetic induction period, the pO2 will increase slowly at first and then will
increase linearly.

6) After 5-10 minutes of linear data collection, turn the light off.  Breathe into the
chamber again and wait for the O2 level to stabilize at or near the original baseline.
Then turn on the light and adjust it to 80% of the initial maximum value; record
another 5-10 minutes of data.

7) Repeat step 6 at 60, 40, 20, 10, and 0 % of the initial light intensity.

8) To alter the wavelength (color) of light, flush the chamber again with your breath.
Start an experiment at full intensity of white light, then alter the wavelength at
maximum intensity by placing different colored filters over the leaf chamber,
under the beaker of water.  Allow each reading to proceed until a uniform rate is
established, usually about 5 minutes.  Between filters, turn of the light and change
the water.
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9) After you have made all of your measurements, click on "Stop" and SAVE YOUR
FILE using "Save as…" in the File menu.  Give your data an appropriate name and
save it to the desktop or your own data folder.

10) Remove the beaker of water, turn off the light.  Place the acetate grid on the
surface of the chamber so that it covers the leaf and count the number of interstices
completely enclosed by the leaf area.  Any interstices falling exactly on the leaf
margin should be given a value of 0.5.  Sum the results and divide the total by 4.
The value you obtain is the leaf area in cm2.

Step 3 - Analyze data:

The O2 sensor measures only the partial pressure of O2 (pO2) in the chamber; it does not
measure the rate at which O2 is produced.  To measure the rate of photosynthesis in your
experiment, you will need to measure the increase in pO2 as a function of time.  This can
be measured with LoggerPro as % O2 produced per minute.

1) Open the data file from your experiment.

2) Open the "Analyze" menu and select "Examine."  A vertical line will appear on
your graphs.  You can move the line along the data points on the graph by moving
the mouse.  As you move the vertical line, the numerical display in the box on the
screen will change to show you the exact O2 concentration, time, and/or light
intensity at the point on the graph where the line is situated.

3) To measure photosynthetic rate at any given light intensity, move the vertical line
to the point on your O2 data where you wish to start the measurement of the slope
of the line.  Click on the mouse button and hold it down.  Move the mouse over the
part of the data you wish to analyze, and then release the mouse button, capturing
the portion to be analyzed inside the box that appears.

4) Select "Linear Fit" from the Analyze menu.  In the command box on the screen
you will see the equation for a straight line, y = mx + b, along with values for m
and b.  The value for m, the slope of the line, is the rate of O2 production in units of
% O2 produced per minute.  Record this value.  Close the box on the screen by
clicking in the upper right hand corner.

5) Measure photosynthetic rate at the next light intensity by moving the vertical line
to the linear part of the next data set.  Select the next area of data to be analyzed by
clicking and dragging with the mouse.  Again, select Linear Fit from the Analyze
menu - record the value in the data table.

6) Repeat the procedure for all of the light intensities and wavelengths that you
tested.  You now have all of the data you need to do your calculations.

Step 4 - Calculate:
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Each m (slope) is the rate of increase in O2 concentration in the chamber with time in
units of % O2 produced per minute.  However, these are not standard international units,
nor would they enable scientists to compare your rates to those observed for different
plants or different leaves of the same plant because your data have not been "normalized"
to leaf area or mass. By convention, plant scientists have agreed to express rates of
photosynthesis as the number of micromoles (µmol) of O2 produced per square meter of
leaf area each second (µmol m -2 s-1).  To convert, do the following:

Each 1% O2 in the chamber = 10,000 parts per million (ppm) = 10,000 microliters (µL)
per liter of gas in the chamber.  Therefore, multiplying m, %O2/minute, by 10,000
µL/liter/percent = the number of µL of O 2 produced per liter of air, per minute (A).

At standard temperature and pressure (STP), 1 micromole (µmol) of any gas occupies
22.413 microliters (µL) of volume.  At the temperature (T in °C) of the lab (= 23°C),
dividing the number of µL of O 2 produced per liter per minute, (A), by {[(273 + T)/273]
x 22.413 µL/µmole O 2} = the number of µmoles of O2 per liter produced/min (B).

Multiplying (B) by the volume of the leaf chamber, which is 0.009 liters (L), yields a
volume-independent rate in µmol O2 produced per minute = (C).

Dividing C by the leaf area in square meters (NOT SQUARE CENTIMETERS - 1 meter
= 100 centimeters) gives the µmol O2 produced per minute per square meter of leaf area =
(D).

Finally, dividing D by 60 seconds per minute gives E, the photosynthetic rate in µmoles
of O2 produced per square meter of leaf area each second.  The abbreviated units are
µmol/m2/s or, preferably, µmol m -2 s-1.

Do these conversions for all of your slopes.

Step 5 - Report:

Write report - organize it as follows:

On the first one or two pages, neatly show all of your calculations from Step 4, canceling
units; turn in a copy of your data graphs with the slopes annotated.

Provide a computer-generated graph of your light intensity data with photosynthetic rates
in µmol m -2 s-1 on the Y axis (ordinate) and light intensity (µmol photons m -2 s-1) on the X
axis (abscissa).  Label both axes clearly and correctly with proper units.

Present your wavelength data in a table similar to the one below.

Answer the questions below.
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Color of Filter m = % O2 min-1 Photosynthetic Rate
(µmol m-2 s-1)

None

Red

Blue

Green

Questions:

1) Was there a light intensity beyond which rates of oxygen production did not increase?
If so, this is the light saturation point for photosynthesis.  If not, why do you think
your leaves did not reach the light saturation point?  Describe how you would design
an experiment to test your hypothesis.

2)  When you used colored light filters, was the intensity of light coming through each
different filter the same?  If not, how has this affected your conclusion?  If the
intensities were the same, does this mean that the amount of energy coming through
each filter was the same?  Why or why not?  In light of your answer(s), describe how
you would re-design your experiment to address these questions.


